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TERMINOLOGY 

POWERPOINT SCREEN 

When you start PowerPoint, you have the choice of taking a new blank document or choosing a theme 

and you can start writing your text. This window contains useful elements for performing many 

functions. 

For each open document window, you will find an icon in the taskbar indicating the name of the 

document. 

 

Tabs 

The tabs are located directly below the title bar. The Close button on the far right will close the 

document, the PowerPoint program remains open.  

  

 

  

Display mode 

Home Tab Group Font View Tab 
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Quick Access Toolbar 

From the File - Options - Quick Access Toolbar tab, you can add other buttons not available in the 

ribbon groups, you can also click this button to access them. 

 

 

 To display below the ribbon, add or customize the Quick Access Toolbar: Click the command 

button on the far right. 

 

Groups 

Command buttons in the « Font »group and « Drawing »Group. 

The dialog boxes are located below the commands 

   

Dialog box unwinder 

We find dialog boxes by clicking on the button in the lower right corner of a group. 

Instant Toolbar 

When you select a portion of text, a small Formatting toolbar appears to make it easier to edit the 

selected text. 

 



FORMATION CAD INC 

P a g e  | 6 

Galleries 

We will find galleries to modify the appearance of a table, a style, a graph, a picture, etc.  

You click the arrow on the right to open the gallery. 

 

 

SLIDES GROUP 

New Slide 

 Click New Slide: 

 Choose the slide layout from the Layout gallery (Ex. “Title and Content”) 

 

Layout 

 Allows you to change the slide layout to another type. 

Reset a slide 

 Erase all formatting that has been applied and return it to 

its original appearance. 
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Format painter to reproduce formatting 

 The format painter is a very important tool, it will reproduce the formatting 

of the text to be modified in a very effective way. Select the text you want 

to reproduce, then click once in the painter, or 2 times in the painter to 

reproduce as many times as you want, then select the text you want to 

edit. 

 To disable the painter, click Esc or click the painter again.   

PRESENTATION VIEWS 

The different presentation views allow you to get the best point of view depending on the work to be 

done. The presentation views can be changed directly in the status bar or View tab. 

 

 

The « Slide Sorter » view 

The « Slide Sorter »view is mainly used to better visualize all slides, to select for printing, to hide certain 

slides, better visualize transitions, etc. 
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The « Normal »view 

The « Normal »view allows you to work on slides. 

 

The « outline »view 

Working in « Outline » view is a good way to work when starting a 

presentation, you can enter the slide titles and all the important elements. 

   

The « Slide Master »view 

The « Slide Master »view allows you to create a style that will apply to all slides, we are talking here 

about the font, bullets, paragraph, picture, shapes, header and page of page and Custom theme.  
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Other available views 

 

  « Notes page »: Page to print before presentation 

MEMORY HELP 

 « Reading Mode »: this view is similar to displaying 

« Slideshow ». 

 « Handout Master »: Layout of the document to be 

printed with header and footer. 

 « Notes Master »: Printable document layout with note 

page header and footer, insert slide. 

 

FONT GROUP 

For editing text, such as font style, bold, italics, color, etc. 

You can find more options by opening the dialog box: 

Font 

 Small caps 

 All Caps 

 Superscript and Subscript 

Character spacing 

 Normal 

 Extensive 

 Condensed  
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Change case 

How to Change the Case of Text 

Here is the step to follow when you want to edit a document from lowercase to uppercase or vice versa 

Home Tab  Font Group  (Change Case) 

 

 

Remove formatting 

 How to remove all character 

formatting. 

 Select the text whose formatting you 

want to remove. 

 From the Font group (Clear All 

Formatting). 

GROUP: PARAGRAPH 

Click on the Home tab, Paragraph group. 

Alignment 

 Left alignment (CTRL + L) 

 Center alignment (CTRL + E) 

 Right alignment (CTRL + R) 

 Justify alignment (CTRL + J) 
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Paragraph indentation 

Line spacing 

Paragraph spacing 

 This space is significant to obtain a 

clearer text with each line change. 

 Example below: 
 

 

Convert your text to smartart 

 Select the text, then click the « SmartArt »button for Paragraph group. 

   

Align text vertically 

Button appreciated in PowerPoint to get the text box centered vertically. 

  

               

        

 ia ete  i  a    oni  di ea e    t ta in   atte   into  o   o n  and   an   e ent lon  te  

 o  li ation  o   ette  t eat t e .

           

T e e a e  e e al  ind  o  d     to lo e    ole te ol  ea   di  e in  a little   o  t e ot e     

it  e  e t  on   ole te ol  it   a  o  a tin   and it   ain  ide e  e t .
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Bullets and Numbers 

Click on the Home tab, paragraph group. 

 

Click the arrow to change the bullet. 

 

For even more options, click the Bullets and 

Numbers button at the bottom of the window to 

edit: 

 Size 

 Colour  

 Other bullets 

 

TABS 

In PowerPoint, when you press the TAB key, the insertion point automatically moves 1.25 cm (0.5 

inches) from the left margin. However, the default tab is not always appropriate when you want to 

create a list of multiple columns on a single row. In this case, it is best to customize the tab. 

You can customize the tab from the horizontal ruler or dialog box in the Home Tab - Paragraph - 

Group 
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There are four types of alignment 

TAB FUNCTION 
 

Left The left edge of the text is aligned with the tab stop 
 

Center Text is centered on the tab stop 
 

Decimal The decimal separator is aligned with the tab stop 
 

Right The right edge of the text is aligned with the tab stop 

keyboard shortcut: Inside the Slides and Outline view: 

KEY (S) DISPLACEMENT 

Enter To move to the next point (same level) 

Tab To increase shrinkage (Lower level). Moves to next level 

Uppercase+Tab To decrease indent (level up): Moves to previous level 

Uppercase+Enter To move to the next line without changing levels (inserting a line break) 

Ctrl+Enter Switch to a text box (will create a new slide if there is no text box) 

SPELLING 

Click on the Quick Access Toolbar or press F7, choose  from the « Review » tab. 

 

To correct a word without going through Review tab (Spelling), click in the word with the right mouse 

button « contextual », PowerPoint offers you a choice of word, click on the corresponding word, 

PowerPoint will make the correction for you. 
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DESIGN - THEMES 

 

A theme includes various formatting elements. It includes colors, fonts, and graphic effects. It does not 

include text or object (manageable object).  

In « Normal », « Slide Sorter » or « Notes Page », the theme name of the active slide appears on the 

status bar (at the bottom of the screen).  

If the name does not appear, check that the corresponding option is enabled: right-click on the status 

bar and check the « Theme » box. 

Save Current Theme 

Be creative, you have created a beautiful background and you want to keep this style for future 

presentations. Same principle for « Search for a theme ». 

Search for a Theme 

OR search for a template, Design tab, Theme Gallery, click « Search for themes... » 

 

Choose « Save active theme... » in the « Theme » gallery. 

Color - Background 

A background style can be added to a set of slides in the presentation.  
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We place ourselves in « Normal » display mode, so that we can view the effects of the tried 

backgrounds on the active slide.  

Select the affected slides (if necessary). On the « Design » tab, in the group « Variants », activate 

the « Format Background » button.  

The format background gallery appears. By pointing to a style, you can view the background on the 

active slide.  

 If you click a background style, it will be applied to all slides of the same theme as the active slide.  

 If you want to apply the style to the entire presentation, or only to the selected slides, right-click on 

the style, and then choose the option you want.  

To regain the original background of the theme, apply the theme again.  

You may want to hide the graphic objects included in a theme: select the slides, and then select the 

« Hide background graphics » check box. Click in Format Background, to open a new box. 

Example  

 Select slides that have been given a theme with a lot of colors, then select   the « Hide 

background graphics » checkbox. The blue wave will be masked.  

 A theme does not have a manageable graphic object. These are objects included in the theme 

(non-selectable).  

Hide background graphics 

Sometimes a template suits us, but graphic or other elements could disturb in the presentation of a 

slide. We can therefore Hide background graphics, which means: hide the headers and footer, logo 

or any fancy in the background. 

 

To edit all slides, choose Apply to All, otherwise the background applies only to the active slide. 
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CREATE SECTIONS 

If the presentation includes slides that should be managed in groups, create sections to facilitate their 

management. The ability to create sections is new in PowerPoint 2016.  

 

Utilities: you can move, format, print the slides of a specified section.  

By default, there is only one section, named « Default Section ».  

By inserting a first section, two groups of slides are created.  

With the presentation displayed in « Normal » mode or « Slide Sorter » mode, to insert a section:  

 Click between the two chosen slides.  

 On the « Home » tab, in the « Slides » group, activate the « Section » button Add Section. 

 A bar displaying the name of the section, represents the section.  

 After clicking on this bar to select the section, the menu of the « Section » button allows you to: 

rename it, delete it, or delete all the sections, reduce everything (only the section bars remain 

displayed) or expand everything.  

 To collapse or expand a single section, double-click its section bar.  

  Or click on the symbol  or  just before the section name. 

 By right-clicking on the section bar, other options are offered. You can delete the section and its 

slides, also move the section up (if it is not first) or move the section down (if it is not last).  

 To print the slides in a section, open the File - Print menu. Then in the first drop-down menu under 

« Settings », select the desired section. 

MASTERS 

Master view allows you to work on the raster of slides, documents, or note pages.  

There are three types of master views: slide master, handout master, and note page master (or note 

pages).  

Changes to the document master appear in the plan, so there is no plan master.  
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The advantage of masters is to allow you to process the whole set in a single operation, a set of slides, 

all the pages of the document or all the pages of notes. 

Example:  

If you insert a graphic object into a slide master, it will be inserted on a set of slides.  

 To display the presentation in Master view: on the « View » tab, in the 

« Master Views » group, click the button corresponding to the type of 

master: slides, handout or notes. 

 A tab with the mask name appears.  

 To exit mask mode, click on the last button « Close Master View », or 

activate the « View » tab and choose the desired view mode.  

Slide master 

 

 On the « View » tab, click « Slide Master ».  

GRAPHIC OBJECTS 

In a slide, you can insert various graphic objects:  

Images, video or audio objects, automatic shapes, action buttons, text boxes, WordArt, SmartArt, 

charts 
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The management of these different types of objects (selection, size, copy, positioning, alignment, 

distribution, display priority, deletion) similar for the different types of objects, it also applies to 

placeholders. We deal with graphic objects from the « Insert » tab « Shape Format ».   

We parameterize the formatting of graphic objects, including that of placeholders and elements of 

diagrams or charts, using the commands available on the « Format » tab of the selected object 

(tab named « Insert » group « Illustrations » for a chart).   

On this tab, we often use the « Shape Format » window of the selected object. To view it, simply click 

on the launcher  of the « Styles » group of the object. 

Examples of formatting: 

 Applying a style, defining a border, a fill, an effect (shadow, light, 3D...).  

Pictures 

Online Pictures or This device or Photo library 

Under the « Insert » tab, in the « Images » group, here are the options available to you: 
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Picture from a file  

In the « Insert Picture » window that appears, browse your folders and files to find the image of your 

choice, and double-click it to insert it. Or click on the image and activate the « Insert » button.  

Screenshot  

You can also insert on a slide a screenshot, whole or in part.  

Inserted on the slide, the screenshot has the nature of a picture.  

New in Office 2016, the « Screenshot » button, located in the « Pictures » group of the « Insert » 

tab.  

To be available for a screenshot, the window must come from a file: Open, and 

not reduced to a title bar in the taskbar (the file being active, we click on the 

button  at the top right of the screen).  

To insert an entire screenshot: activate the « Screenshot » button and select the desired window.  

To insert a partial screenshot: activate the « Screenshot » - « Screen Clipping » button. Click and drag 

on the selected window to insert the part you are interested in on the slide.  

This image can be saved in your computer. 

Picture FORMAT 

To edit the image, use the commands on the « Picture Format » tab. 

 

Several groups are available: 

 Size 

 Arrange 

 Adjust 

 Picture Styles 

To insert a picture into a predefined shape: in the « Picture 

Styles » group, activate the « Picture Shape » button, then 

select the shape. This makes it possible to cut the picture 

according to the chosen shape.  
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Crop a picture. 

On the « Picture Format » tab, in the « Size » group, click on the « Crop » button.  

  

To crop two sides at the same time identically: Ctrl + click and drag on a handle located in the middle 

of one side of the image. To crop the entire image: Ctrl + click and drag on a corner handle.  

Finally, disable the crop button.  

To restore the original image, activate the « Reset Picture » button in the « Adjust » group  

(left).  

« Crop to Shape »  

After selection, you can crop an image, by cutting it according to the chosen shape: in the « Size » 

group (« Picture Format » tab), activate the « Crop » button - « Crop to shape ».  

The shape is scaled to the image.   

Example of an oval-shaped cropped image:   

 

To change the aspect ratio of an image that has been cropped: select the cropped image, then activate 

the « Crop » - « Aspect Ratio » button.  
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Transparent color 

« Set Transparent color » a picture is used to erase the color of its background. 

On the 'Picture Format' tab, in the 'Adjust' group, activate the 'Color' button, then click on the 'Set 

Transparent Color' pencil. 

 

 

 

Image compression  

To display the « Compress Pictures » window: after selecting an image, click on the « Compress 

Pictures » button of the « Adjust » group on the « Picture Format » tab.  

Activating the « Options » button displays the « Compression Settings » window. 

Shapes and Action Buttons 

Shapes Gallery 

To display the gallery of predefined shapes, also the action buttons:  

 On the « Home » tab, in the « Drawings » group, press the 

« Other » tooltip button   Or: on the « Insert » tab, in the 

« Illustrations » group, activate the « Shapes » button.  

 The gallery displays first the recently used shapes, then all the 

shapes classified into 9 categories, finally the action buttons.  

Inserting a shape  

 Select a shape. On the slide, the pointer changes to a black 

cross. 

 If you want to insert a predefined shape without changing its size: 

Click the slide. You can change its size then, by clicking & 

dragging on its handles.  

 If you want to change the size: click and drag on the slide.  

 To modify the shape and keep it a similar or regular shape: Shift + 

click-drag (example: a circular shape will remain so).  
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 To draw the shape from its center: Ctrl + click-drag.  

 To use this method, the shape must not belong to the « Lines » category.  

 If you want to insert the same shape multiple times, right-click on the shape in the gallery - Drawing 

Lock Mode. Finally, press Esc.   

 As soon as the shape is inserted, the « Shape Format » tab of the « Drawing Tools » appears. As 

the name suggests, it contains commands to change the format of the shape.  

 The inserted shape is selected: if it has a frame, its outline is a continuous line with handles. 

Otherwise, the handles are on the shape.  

 

 The colors of the shape depend on the theme of the slide.  

« Curve », « Freeform », « Freehand drawing » (category « Lines ») 

« Curve »    

 Click the slide to start drawing, and then release the mouse button. Drag the pointer. Click to 

change direction, release, slide... Keep it up: click, release, drag.  

 Double-click to complete the drawing. Or click the starting point to get a closed shape (the inside 

of the shape changes color).  

« Freeform »    

 Click the slide to start drawing.  

 To draw a broken line: as for a curve (see the previous 

shape), click, release, drag. Unlike the curve, the 

corners of the line are not rounded.  

 To draw a freeform: click and drag (as with a freehand 

drawing). One can thus combine broken line or simple strokes, and free forms. Double-click to 

finish the drawing or click the starting point to get a closed shape (the inside of the shape changes 

color).  

« Freehand drawing »    

 Click and drag to draw. The pointer is in the form of a pencil  Release to finish.  

Selecting a shape, entering text, and deleting  

 To select a shape, point to it or its outline. When the pointer is in the form of an arrow, click. The 

outline of its frame is a continuous line.  
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 If it is a Line, Arrow, or Connector shape in the Lines category, it does not have a frame. It is 

selected as soon as its handles are visible.  

 After selection, you can enter text, unless it is an Arrow Line or Connector shape in the Lines 

category. As soon as a text is entered, the outline becomes a line of discontinuous lines.  

 Very convenient: in text input mode, to select the shape, simply press Esc.   

 To delete a shape, select it and press the Del key.  

Change the points of a shape. 

You can change the look of a shape by clicking and dragging on its points.  

 To change the points of a shape, they must be displayed first: right-click on the shape - Edit points.  

   

 To move a point, click and drag on it.  

 To add a point: right-click at the desired location. To delete a period: Ctrl + click on it.  

Replacing one shape with another  

 Select the shape you will replace. On the « Formatting » tab, in the « Insert shapes » group, 

activate the « Edit shape » - Edit shape button. Click the new shape that you want.  

Text box 

To insert a text box: on the « Insert » tab, in the « Text » group, click the « Text Box » button. 

To configure the text, you can use the commands of the « Font » and « Paragraphs » groups 

(« Home » tab), as well as the « Format shape » window (display it by 

activating the launcher of the « Shape Styles » group (« Formatting » 

tab) in the  »Text box » section.  

On an object where it is not possible to write, one can always add a 

text box.  

The text box is an Auto Shape, present in the « Master Shapes » 

category    (it is the first shape in this category). The previous paragraph « AutoShapes » applies.  
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WordArt 

A WordArt is a text presented artistically. 

 

It can be considered, at the choice, as a formatting of characters or as a graphic object. The result is 

the same.  

Select the text beforehand, or you will then write it instead of « Your text here ».  

To display the WordArt gallery: on the « Insert » tab, in the « Text » group, activate the « WordArt » 

button. Click the desired effect.  

To format the text and shape, use the « Formatting » tab of the « Drawing Tools ».  As far as the text 

is concerned, one can use the commands of the « Police » and « Paragraph » on the « Home » tab. 

SmartArt 

To display the gallery of diagrams, also called SmartArt graphics, activate the « SmartArt » button in 

the « Illustrations » group on the « Insert » tab.  

Or, on the slide, in a placeholder for content, click the icon  .  

 

The tooltip for the « SmartArt » button specifies that a SmartArt graphic is used to « visually 

communicate information. »  

There are seven types of SmartArt, each offering multiple templates.  

In the « Choose a SmartArt Graphic » window, select a type on the left, and then select a template in 

the center. On the right, is described the chosen model. Confirm.  

You can enter text either directly into a shape on the chart or into the pane that appears by clicking the 

arrow button to the left of the chart. Text can be formatted in this pane (it will only appear in the shape), 

or directly in the shape.  
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As soon as the SmartArt, or one of the shapes of its content, is selected, SmartArt tools are available, 

spread over the two tabs « SmartArt Design » and « Format ».  

Charts 

A chart represents data selected from a worksheet.  

To display the « Insert Chart » window, click on the « Chart » button in the « Illustrations » group, 

under the « Insert » tab.   

Or, on the slide, in a placeholder for content, click the icon  .  

In the dialog box, select a type on the left, and then select a template in the center.  

An Excel window appears on the right, containing a table of data.  

 

On the left side, the chart corresponding to this data, is inserted into the slide.   

Replace the displayed headers and data with your own, add or remove rows or columns. The graph 

is modified accordingly.   

Use the commands on the chart tool context tabs: « Chart Design », 

and « Format ».  
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Table 

When you create a table, PowerPoint inserts it at the insertion point. The table automatically extends 

from the left margin to the right margin of the document, and all cells in the table are of the same 

dimension. 

To create a Table, click on the Insert tab, then (Table). 

 

When you have inserted a table, 2 tabs are added to the ribbon: 

 Layout tab of the context menu 

 Table Design tab of the context menu 

 

Insert rows and columns. 

 

Delete rows and columns in a table. 

Size and alignment 
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Table style (Template) 

In the Table Design tab, you will be able to choose a table style, click on the button at the far right of 

the Group (Table Styles) 

OBJECT MANAGEMENT 

« Selection and visibility » pane 

Lists the names of the objects on the slide (visibility); - It also allows you to select objects (selection). 

To display it, a graphical object must be selected.  

Activate the « Format » tab (named « Formatting » if the selected object is a chart), then in the 

« Arrange » group, click the « Selection Pane » button. The pane appears on the right side of the 

screen.  

 To select an object, click its name in the pane.  

 To select more than one: Select the name of an object, and then Ctrl + click each subsequent 

object name.  

 Highlighting a name in the pane means that the object is selected, or that the object is in text input 

mode.  

 To hide an object, click the eye icon to the right of its name. You can widen the pane by clicking-

dragging (double-arrow pointer) on its left border. By default, objects are displayed. The eye 

disappears from the box when the object is hidden. Click the empty box to display the object 

again. 

 You can change the order of the object names: select the name, then use one 

of the two arrows at the bottom of the pane or located near the « Show & Hide 

All » label  

 On the slide, after selecting an object, you can reach the next object (whose name is the following 

in the pane list) by typing Shift + Tab. 

Selection 

 Before managing one or more objects (sizing, copying, moving, etc.), you must designate them by 

selecting them.  

 Objects can be selected by selecting their names in the « Selection and visibility » pane.   

 There are other ways to select one or more objects:  
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Selecting an object  

 Object without text (picture or shape without text): Point to the object. When the pointer is shaped 

like an arrow cross, click.  

   

 Object with text: Click the object, and then press the Esc key.  

 After selecting an object, to select the next one, which is the one that follows it in the list of the 

« Selection and visibility » pane: Shift + Tab  (this deselects the previous one).  

Selecting multiple objects  

 Press Ctrl + click on each object you want to select.  

 Or, if possible, it's faster to click and drag a rectangle on the objects you want to select.  

Select all objects on the slide  

 Type Ctrl + A.  

Group objects 

One may want to group objects to manage them into a block, especially to move or resize them. A 

SmartArt has automatically grouped shapes.  

 Select the objects to group (Ctrl + click). A text placeholder cannot be part of the group. On the 

format tab, in the « Arrange » group, activate the « Group » button, and click Group. 

 The « Selection and Visibility » pane displays the group and lists the objects it contains. A frame 

surrounds the grouped objects. A group is considered an object. 

 To ungroup the objects in the group, select the block, then activate the « Group » button and click 

Ungroup. 

 It is then possible to group them: select an object from the group, then activate the « Group » 

button.  
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Size 

With the handles  

 When selected, an object has handles. 

 Point to a handle on the stroke. When the pointer is shaped like a double 

arrow, click and drag. Click and drag on a corner handle to preserve the 

aspect ratio.  

With the ribbon  

 Display the « Size and position » window: on the format tab of the selected object, click on the 

launcher of the    « Size » group. Fill in the window opened with the « Size » Group.  

Copy, duplicate 

Copy  

 Point to the outline, outside the handles. When the pointer is shaped like an arrow: Ctrl + click-

drag.  

 To copy horizontally or vertically: Shift + Ctrl + click-drag.  

 Copy the same or another presentation to another slide, or to any document in an Office application  

 Copying can be done with one of three methods:  

 Right click - Copy or Ctrl + C or Click on the Copy button on the clipboard (« Home » tab).  

 Pasting can be done with one of three methods: Right-click - Paste or Ctrl + V or Click the Paste 

button on the Clipboard.   

Duplicate  

 Duplicating an object into one or more copies is fast. Note: The object is not copied to the 

Clipboard.   

 The copies are placed behind the original object.  

 To duplicate an object, click on the drop-down menu of the « Copy » button (« Clipboard » group, 

« Home » tab) - Duplicate.  

Position, Align 

Moving Objects 

 Point to the outline, outside the handles. When the pointer is in the shape of an arrow, click and 

drag.  

 To move horizontally or vertically: Shift + click and drag.  

 When moving an object, you can use the dotted lines that appear on the horizontal and vertical 

rulers. They mark the coordinates of the black cross of the pointer.  
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 Move to another slide (from the same or another presentation), or to any document in an Office 

application  

 The move can be done with one of three methods:  

 

 Right click Cut or Ctrl + X or Click on the Cut button on the Clipboard (« Home » tab). 

 Gluing can be done with one of three methods:  

 Right-click Paste or CTRL or Click the Paste button on the Clipboard.   

Small trips  

 One can make small moves of the object using the arrow keys on the keyboard, and even smaller 

moves, by pressing the Ctrl key, while using the arrow keys.  

Precise position in centimeters  

 You can set the position of an object in the slide via the « Format » window 

opened on the « Position » tab.  

 To view it, right-click on the Format... Then open the « Position » tab.  

Alignments: horizontal and vertical  

 To align the objects on the slide, use the drop-down menu of the « Align » button which is locating 

the « Arrange » group under the Format tab. 

 There are three horizontal alignment options: left, centered, and 

right.  

 Three vertical alignment options are available: top, middle, and 

bottom.  

Distribution of objects  

 To distribute the objects, we use the « Distribute horizontally » 

and « Distribute vertically » options proposed by the « Align » 

button (format tab, « Arrange » group).  

 If the « Align selected objects » option is enabled, the 

distribution is performed at the space level between the objects.  

 If the « Align to slide » option is enabled, the distribution is done 

at the slide level.  
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 It may be necessary to activate the « Align » button a second time in order to have the desired 

alignment and distribution options.  

Rotating an object 

 With the green handle (when the object has one)  

 Click and drag on the green handle of the object, in order to rotate it. 

 With the ribbon: We use the options of the « Rotate » button, under the format tab of the 

« Arrange » group.  

 The « Other rotation options » option is used to display the « Format » window on the « Size » 

Group. It can indicate the exact angle of rotation desired.  

Display priorities 

 When objects are superimposed, the « Forward » button or the « Backward » button in the 

« Arrange » group of the format tab, is used to indicate the display priority of a selected object. 

 Example: in the set of objects on the right, the core is in the foreground, the head in the 

background, the arrow in the background of the other two objects.  

SAVE A PRESENTATION 

We will find this window from File then Export and then Change File Type   
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Save-as - Other format types 

 Slideshow: .pps - ppsx 

 PowerPoint: ppt – pptx 

 Model: pot - potx 

 As Image: Jpg. - Png.  - Tiff, etc.  

 To save the slide show in « PowerPoint 

Slide Show » format:  

 View the presentation. Open the File menu 

- « Save and Send ».   

 Under the heading « File types », select 

« Change file type ».  - In the right pane, 

select « PowerPoint Slide Show (*. ppsx) » 

- Under the right pane, activate the « Save 

As » button. Save and validate  

LAYOUT 

To choose the layout, click in the « Design » tab of the « Variants » Group  

 

Then - Custom slide size ... 

   

We need to decide if the slides will all be in portrait or landscape mode,  
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HEADER AND FOOTER 

There are 2 kinds of header and footer: 

 Slides 

 Comments and documents 

Slide header and footer 

To insert page headers, click on the Insert tab - Text group 

  Click Apply to All 

 To edit on a single slide, simply click Apply 

Document header and footer 

 This one is for printing purposes 

PRINTING A PRESENTATION 

Print preview 
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Print dialog box 

 Choose the number of copies to print  

 Select the printer if necessary 

Settings 

 Choose slides to print Ex. From 1 to 3, slides 6 and 9 

 Print all slides 

 Print slide in Progress 

 Print selection 

Slides 

 Number of slides per page, Outline view and comment pages) 

 

 Portrait Orientation or Landscape 

 

 Color 

 

 

 

Attention:  If you click on « Print » without making a printing choice, all slides will be 

printed individually on a whole page, so on a sheet of 8 1/2 by 11 for each slide.  
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TRANSITION 

Transition is the switch from one slide to another in slide show view 

To choose your transition, click on the Transition tab  

Select slides 

 Choose the transition 

 Change the speed 

 Apply manually or automatically 

 If necessary, set a timing before the next slide arrives 

 Choose a sound (Do not abuse) 

 

Transition effects 

One can choose a visual effect and /or a transition sound effect.  

If necessary, first select the slides that will receive the effect (or both effects).  

Visual transition effect 

Under the « Transitions » tab, the « Access to this slide » group is used.  

To view the gallery transition visual effects, use the arrows to the right of the effects. 

Only one effect can be applied.  

Right after clicking on an effect, we get a preview of that effect. Then, we can use the 

« Preview » button, to the left of the effects gallery.  

With the effect applied, it can be edited using the « Effect Options » button on the right side of the 

effects gallery. 
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Manual or automatic switching 

Switching from one slide to another can be manual (you control the passage to the next slide, for 

example by clicking) or automatic.  

 

By default, the passage is manual.  

When the passage is automatic, we must perform a timing, determine the display time of each slide.  

On the « Transitions » tab, « Timing » group, in the « Advance Slide » area, you can Uncheck Box 

« On Mouse Click » 

« Automatically after ». This makes it possible to intervene in manual, while being in automatic mode 

(for example to display the next slide earlier). 

ANIMATIONS 

An animation effect can be applied to any selected object on the slide. We use the commands of the 

« Animations » tab.  

The purpose of animation is to present text, pictures, and others in a more pleasant way. This option 

can be found in the Animation tab. 

 Abrupt entries 

 Rotation 

 Bounce back, and many others... 

 Choice of speed 

 Timing 

 Start before and or after the previous one 

 Automatically or manually 
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The gallery offers four types of effects 

« Entrance » and « More Entrance Effects »  

 The object appears on the slide with the effect animated. 

« Emphasis » and « More emphasis effects »  

 The object, present in the slide, is animated by the effect (Especially the text) 

« Exit » and « More Exit Effects »  

 The object disappears from the slide while animated by the effect. 

« Trajectories » and « Other trajectories »  

The object follows the movement of the trajectory. 

By clicking on « Other... », we open a 

window where the effects are classified into 

several categories. If the « Preview » box 

of this window is checked, we have a 

preview of the effect on the selection of 

objects just after its application. 

In « Normal » or « Slide Sorter » display 

mode, the icon    appears next to each 

thumbnail that contains an object that has 

an animation effect applied to it.  

On the slide, if the « Animations » tab is 

enabled, or if the « Animation Pane » (see 

later) is displayed, an appearance order 

number appears next to each object that 

has an animation effect.  

If an object has multiple effects, multiple 

numbers appear next to it.  

Glimpse 

To preview all the effects of the slide (by default, in the order of their application), except those triggered 

by clicking on another object (see below), click on the upper part of the « Preview » button (first button 

under the « Animations » tab).  
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Selecting effects 

 To select: An effect: click on its line in the pane, or on its number in the slide.  

 Multiple effects: Ctrl + click on each effect line, or on each number in the slide.  

 All effects of an object: Select the object on the slide.  

Removing effects 

 Select the effects you want to delete, and then press the Delete key.  

Three options for the effect are available: 

 « Start by clicking » is the default option. A « mouse » icon  follows the sequence number of 

the effect, which will be triggered by clicking on the slide.  

 « Start with the previous one ». There is no icon for this option.  

 « Start after the previous one ». A « clock » icon follows the sequence number of the effect, 

which will be triggered automatically after the previous effect during the slideshow.  

   

 SLIDESHOW PRESENTATION (F5) 

 

Displays slides one at a time for a computer presentation. This presentation can be run manually: you 

« click » with the mouse to move from one slide to another. The presentation can be displayed 

automatically: each slide remains on the screen for a predetermined time and then moves on to the 

next one.  Slides can contain animation and transition effects and will be displayed with these effects. 

A slideshow can be viewed:  

 Full screen: this is the default option.  

 In Reading mode  

 In a window  
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Full screen slideshow 

To start the slideshow in full screen: F5 or (ALT F5 – Presenter Mode) 

 Click the « Slideshow » button   located in the status bar.  

 The slide show starts with the active slide.  

 Or: On the « Slide Show » tab, in the « Start Slideshow » group, choose « From the beginning » 

or « From the current slide ».  

 To exit the slide show, press the Esc key or the minus key.  

 A toolbar with four buttons appears at the bottom, on the left of the screen (otherwise move the 

mouse to make it appear).  

Slideshow in Reading view 

 Activate the « Reading Mode » button , located on the status bar.  The slide show starts with 

the active slide. 

 Or: under the « View » tab, in the « Presentation views » group, click the « Reading Mode » 

button. The slide show starts on the first slide.  

Hiding slides 

 One may wish not to show some slides from the slideshow.  

 In « Normal » or « Slide Sorter » mode, first select the slides you want to hide. 

On the « Slide show » tab, in the « Configuration » group, click on the « Hide 

slide » button.  

 In « Normal » mode or « Slide Sorter » mode, the numbers of hidden slides are 

crossed out.  

 To remove the masters, select the hidden slides, in the « Configuration » 

group, then disable the « Hide slide » option. The numbers of the « Unhide 

Slide » slides are no longer crossed out.  

Projection in presenter mode 

 Projection in Presenter mode requires two screens to be attached to the computer: one used by 

the presenter, the other facing the audience.  

 When the presenter views the PowerPoint presentation, their screen is different from yours, here's 

what they see: 
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Pen annotation and laser pointer 

Laser pointer 

The laser pointer can be used in Slide Show mode or in Reading 

mode.  

To make the mouse pointer look like a laser pointer, press Ctrl + 

click.  

We will see below that his movements can be recorded.  

By releasing the Ctrl key and the mouse button, the pointer returns to 

its usual appearance.  

Pen button 

In « Slideshow » mode, use the Pen button   (at the bottom of the 

screen).  

 

See other buttons 

Open the presentation you want to project, then launch Presenter view: on the « Slide Show » tab, in 

the « Monitors » group, check the box « Use the « Presenter » mode.  

The audience sees the presentation, slide by slide.  
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The presenter screen contains additional elements: slide thumbnails, next slide buttons, previous slide, 

pen button, slide button, slide comment area, with zoom; it also specifies: the number of the slide 

displayed and the time elapsed since the beginning of the presentation.  

 

 

KEYBOARD SHORTCUT 

CTRL + X Cut 

CTRL + ESC Show Start menu 

CTRL + C Copy 

CTRL + V Paste 

CTRL + Z Cancel an operation 

CRTL + A Select all slides in Sorter view 

Select all text boxes and pictures on a slide 

Or select all text in a text box 

CTRL + P Print the document 

CTRL + END Go to the end of the document 

CTRL + POS1 (HOME) Go to the top of the document 

F4 Repeat the last operation 

F5 View slideshow 

ESC Closes a window in an application 

F7 Spell checking 

F1 Displays help 

This documentation was produced from the SEMÉ 2010 documentation and the CoursBardon training, 

available on the Internet.  

\\Dlink-0e9656\f\Course Notes\2016_MSOffice\PowerPoint\PowerPointLevel2.docx 

  



FORMATION CAD INC 

P a g e  | 42 

POWERPOINT  EXERCISE 1 

Open file: « First Aid » 

Slide 1 

 

A. Type the text in the appropriate placeholders « First Aid » 

B. Insert a picture 

Add a new slide: Title and content 

 

A. Enter the following text: 

B. The text, in the form of a list, must be centered vertically in the placeholder 

C. Change the slide layout for 2 contents 

D. Insert a picture: Name: « BOBO » 

E. Make sure this one is the second slide 
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Slide 3: 

A. Make the following changes: 

 

B. Increase List level (As above) 

C. Use paragraph spacing (your choice) 

Slide 4 

 

A. Change the chip for a phone (Found in « Symbol », Wingdings) 

B. Change the color and size of the chi to 150%  

C. Align text in the middle 

D. Paragraph spacing before and after of 15 pt 

E. Insert a text box on this slide: This number is functional throughout the province of Quebec 

1. Create a footer with the slide number and your name in the center.  

2. This footer should not appear on the title slide 

3. Prepare to print as documents of 3 slides per page 
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POWERPOINT  EXERCISE 2 

Open the « Fishing excursion »file 

A. The theme of your presentation will be in your folder:  

From the presentation « Template Fish » 

Slide 2 

A. Arrange the text in two columns OR maybe see « Designer » 

B. Use paragraph spacing to improve presentation 

Slide 3 

A. Table to create as follows: 

 

Slides 4 

A. Chart to create with the same information from the previous table 

B. Pie CHART 

 

             

                          

      

           

     

                

                      

 

 

 

                   

                



FORMATION CAD INC 

P a g e  | 45 

Slide 5  

A. Convert to SmartArt (cycle) 

 

B. Create a footer with the slide number and the following text: Fishing activity 

C. Hide slide 2 

POWERPOINT  EXERCISE 3 

Open « Veggie for life » 

A. In group « Design »– « Browse for Themes », choose « Template_Food »in your folder  

Header and footer: Type your name in the footer and active Slide Number 

A.  on’t   o  on Title Slide 

B. Apply to all 

Slide 2 

A. Reset slide 2 

   

Slide 3 

A. Convert into « SmartArt » 

 
B. Change color and style 
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Slide 4 

A. Change « Layout for « Two Content » 

 
B. Insert a picture and explore « Picture Format » 

Slide 5 

A. Use « two columns » 
B. Paragraph: Spacing before and After: 6pt 

 

Slide 6 

A. Hide Background Graphics and replace by a picture 
B. Make a few changes  

 

Slide 7 

A. Change layout for « Comparison » 
B. « Ingredients »and « Fruit filling »are dialog box header 

 
 

     

           

                     

          

           

                 

            

                       

                      

                       

                     
      

              

                 

                     
       

                 

                       

          

                    
                      

                              
     

                  

                            

                   

           

                

               

              

               

              

              

          

                                                                         

                                                                      

                                                                           
                         

              
           

       

                    

                                

                         

                            

            

                                     
                

                                  
                                
                           

                                     

                            
                              
       

          

                                                                                        

                                                                                 


